
2. Picture Window Tutorial

To get you started using Picture Window we present two short tutorials. 

Basic Image Editing
This tutorial covers basic operations, like cropping, adjusting brightness, 
color balance, and others that you will use over and over again with your 
images. These operations are characteristic of Picture Window generally, 
so learning them will make you comfortable with using all of Picture Win-
dow. 

Applying Edits to Multiple Images
Once you go through a series of steps to edit an image, you can apply the 
same workflow automatically to any number of other images by simply 
dragging and dropping. This tutorial introduces you to workflows and 
shows you how easy they are to apply.

Original image

Final image
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Basic Image Editing
This tutorial covers basic image operations. The only thing you need to do before you try this guided tour is install Picture 
Window—everything else, including a sample image, is provided. So start Picture Window by double-clicking its icon and 
then load a sample image. The procedure for loading the first sample image is next.

The Opening Screen

Cropping the Image

Adjusting Brightness and Contrast

Adjusting Color Balance

Sharpening the Image

Adjusting Color Saturation

Brightening a Small Area

Saving the Image

Using Other Transformations
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The Opening Screen
When you first bring up Picture Window, you get a display like 
that shown at right. The menu and tool bar are displayed at the 
top of the window. A Browse window at the left shows thumb-
nails of images in any selected directory. (If the Browse window 
is not displayed, just click the button in the main tool bar.)

Loading an Image
The first file we want to open is bird.jpeg located in the Pic-
ture Window installation directory. The extension jpeg indi-
cates the file is compressed using the JPEG standard. JPEG is 
designed specifically for photographs and easily achieves com-
pression factors of 6 to 10 with good quality. 

To load the image using the browse window:

4. Select the Picture Window installation directory. In 
the browse window, click the button. The Select 
Folder dialog is displayed. Navigate to the installation 
directory. Click the Select button. All the images in the 
directory are displayed in the browse window.

5. Open the bird image. To open Bird.jpeg, double-click on the image or drag it to the work area. The image is dis-
played in its own window. 

You can also load images using the standard File | Open or File | Open Photo CD dialogs. (See Opening Images.)
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The Image Window
Notice that the image is displayed in its own image 
window. Since the image window is used throughout 
Picture Window, it is worth noting some of its fea-
tures. 

The title bar of the image window shows the file name 
of the image. Or, if the image has not yet been stored 
in a file, the title bar displays an image number. During 
a session, increasing image numbers are always 
assigned, so that you can be sure that a greater num-
ber means it’s a later version. 

The title bar also displays the image’s magnification. 
You can change the magnification with the Zoom but-
tons in the tool bar. 

Zoom in: Enlarges the image within the image window.

Zoom in and enlarge window: Enlarges the image. Also enlarges the image window, if possible.

Zoom out: Reduces the size of the image and shrinks the window.

When the image is magnified so that it is larger than the image window, you can drag the image around inside the window 
by clicking the Hand button in the main toolbar. You can also use conventional scroll bars.

Finally, note the number in the upper left corner of the image’s border. It indicates the number of bits per pixel. Full color 
images have 24 or 48 bits/pixel. Monochrome images have 8 or 16 bits/pixel. 1 bit/pixel images are also possible.
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Evaluating an Image
After you first display an image, evaluate it 
for a moment. What would you do to 
improve it? Very few photographs are fin-
ished when they come out of the scanner.

Frequently, the photographs we take have all 
the essential ingredients to be good images 
once their strengths are brought out and the 
impact of their defects is reduced. 

The image at the top left is a photo of a fabu-
lous bird, as it looks after scanning. By 
inspecting it critically, you can see a number 
of things that can be improved. The image 
contrast is subdued, it has a slight green 
color cast, and focus is soft. 

On the following pages we work on the 
image in stages, making a series of improve-
ments. Their cumulative effect is the second 
image shown at left. 

To learn the most, load the image and per-
form the steps yourself as you read. 

Original image

Final image
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Cropping the Image
Since cropping makes the image smaller 
and thus more manageable for your 
computer, it’s a good idea to crop the 
image early in the enhancement pro-
cess. However, if you are not sure 
whether you want to leave a feature in 
or out, leave it in. You can always crop 
it out later. 

So let’s start by cropping the image. 
Crop is an image transformation, 
located in the Transformation menu. 

Click on the menu. You will notice that 
it contains a long list of operations. The 
three major categories are Geometry, 
Gray, and Color. Gray contains all the grayscale (i.e. black and white) operations for controlling brightness and contrast. 
Color contains functions for adjusting color balance and color saturation. Geometry is the one we want to choose. In 
addition to cropping, it contains functions for resizing images and for controlling perspective.
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The Crop Procedure
To crop the image:

1. Click on the image window to make sure that it is selected. 
In Picture Window, you select the image window first and then 
select a transformation for operating on the image. 

2. Display the Crop/Add Border Transformation. In the 
Transformation menu, select Geometry and then select 
Crop/Add Border. The dialog box is displayed. Notice also, 
that there are little open squares in each corner of the image. 
These are “handles” that you can drag with the mouse to 
adjust the cropping rectangle.

3. Drag the crop rectangle handles to achieve the crop you 
desire. You can drag the corners or edges to adjust the size of 
the rectangle. You can also drag the interior of the rectangle to 
reposition it without changing its size. 

To make fine adjustments, enlarge the image window by press-
ing the tool bar button or selecting the Zoom In menu 
choice in the Window menu.

4. Preview the crop. To see the effect of the crop, click Pre-
view. A small version of the image is displayed in a preview 
window. You can enlarge the preview window too, by selecting 
the window and pressing the tool bar button. You can 
make further adjustments and preview the image again as nec-

Cropping: In this example, we dragged the right 
edge of the crop rectangle to the left to cut out the 
extra space. The result is below.
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essary.

Most dialogs have a Preview button. It lets you see the results of your editing without leaving the dialog. The pre-
view image has only as much resolution as is needed for the screen, so your changes can often be applied much 
faster than to the full image. 

5. Click OK. When you are satisfied with the changes, click the OK button. The cropped image is displayed in a new 
image window. (Note, if you want to try additional variations, click the Apply button instead. Clicking Apply leaves 
the dialog up and allows you to make additional images.)

Hint: Sometimes transformation dialogs get buried under other windows. Just click the  button in the tool bar 
to bring all transformation dialogs to the top.

Pipeline Editing
Notice that you now have two image windows—one with the unchanged original image 
and the other with the changed new image. In Picture Window, most editing operations 
are not performed in place on the original image, but rather produce a new image. That 
way you can compare the new version with the previous one and continue from the 
one you like best. Also, you can easily return to a previous version, even if it’s several 
stages back. This is particularly helpful when you are experimenting. You can save any 
image to a file at any time. On the other hand, if you don’t think you will be returning to 
a particular intermediate step, you can delete its image window, to conserve memory. 

As you continue editing and the number of open windows accumulate, you might have 
trouble finding the window you need. One way to locate the right window is to use the History Display (Click the His-
tory tab at the top of the Browse display.) It shows a hierarchical list of open windows. To select a window just double-click 
on its title. 
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Adjusting Brightness and Contrast
Usually, brightness and contrast are among the most important adjustments you 
can make. You can think of brightness as being how light or dark the midtones of 
the image are. Contrast is the range of tones—from the darkest shadows to the 
lightest highlights. 

Usually your goal is to make the shadows as dark as possible while retaining just 
a hint of texture and detail in most of the shadow areas. Likewise, you usually 
want to adjust the highlights so they are as white as possible, but also with a little 
bit of texture and detail. Finally, you want to adjust the midtones so they look 
realistic. 

Evaluating the Sample Image
Let’s look at the sample image with these criteria in mind. Compare the brightest feathers with the white of the border. 
They are not nearly as bright. Thus the bright areas of the bird could be made brighter, giving the photo more snap. Simi-
larly, check the blacks. In this example they are satisfactory, but if they were not, we would want to make them darker.
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Using the Levels and Color Transformation
Picture Window has several transformations for adjusting brightness and contrast. We will use a simple and very effective 
transformation called Levels and Color. It gives you independent control of contrast and brightness as well as color bal-
ance and saturation. In this example, we will only explore its contrast and brightness features. See Levels and Color Dia-
log for information on its color controls.) 

The Levels and Color Procedure
To use the Levels and Color dialog:

1. Select the image window containing the image you want 
to adjust. 

2. Display the Levels and Color Dialog. In the Transforma-
tion menu, select Gray and then select Levels and Color. 
The Levels and Color dialog box is displayed. 

Notice the position of the shadow and highlight sliders on 
the Dynamic Range control. Picture Window sets these slid-
ers to the actual brightness level of the shadow and highlight 
areas of the image. (When you move the sliders, a small 
scale mark shows their original positions.) For instance, we 
can see that the brightest area in our image is only about 
69% of full possible brightness. 
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3. Adjust the dynamic range. A good starting point for this 
adjustment is to simply move the shadow and highlight sliders to 
maximum black and white, respectively, and preview the image. 

The further apart the sliders are, the higher the contrast of the 
image. For very high contrast, you can actually move them past the 
maximum white and black points. That has the effect of emphasiz-
ing highlights and shadows and increasing the contrast in the rest of 
the image.

4. Adjust the Midtones slider. The Midtones slider affects the 
mid-range tones most. Adjust it for the most natural brightness 
level for the subject at hand. We set the brightness to about +25%

5. Preview the adjustments. To see the effect of the adjust-
ments, click Preview. A small version of the image is displayed in a 
preview window. Experiment with different settings and preview 
again, until you are satisfied with the image.

6. Click OK when satisfied with the adjustment. A new image is 
created in its own window. The dialog box is dismissed.

Note that you can also create a new image by pressing Apply instead of OK. See Applying a Transformation for 
a discussion of the two buttons.

The original image 
and after cropping 
and Levels 
adjustment



Adjusting Color Balance
Notice that the whites in the feathers actually have a 
green tinge. We can remove this tinge by rebalancing 
the colors of the photograph, using the Color Bal-
ance transformation.

1. Select the image window containing the 
image you want to adjust. 

2. Display the Color Balance transformation. In 
the Transformation menu, select Color and 
then select Balance. The Color Balance dia-
log box is displayed. 

3.  This transformation tries to determine the correction needed to balance the image. Its guess is frequently quite 
close. Click Preview to see the results of auto-correction. If they are satisfactory, click OK to create a new image. 
If you disagree with the auto-correction, click on any area of the image which should be neutral -- for example the 
highlights in the feathers above the eye would be a good choice. The auto-correction results in our case are shown 
below. 

To bring the image into balance, the Color 
Balance transformation determined that it 
must subtract green. (Note the Remove 
highlight patch above.) The results are 
shown at left. Note that the feathers are 
whiter and the beak is redder. The blue high-
lights in the feathers are also more promi-
nent. 
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Sharpening the Image
Images in which texture or fine detail are important can frequently 
be improved by sharpening their focus. In this image, the feather 
structure is a bit soft, so it is a good candidate for sharpening. To 
sharpen an image:

1. Select the image window containing the image you want 
to adjust. 

2. Display the Sharpen Transformation transformation. In 
the Transformation menu, select Sharpen. The Sharpen 
dialog box is displayed. 

3. There are several sharpening methods. We chose 
Unsharp Mask, which is a good general-purpose sharpening method. All other settings are simply the defaults.

4. Click Preview to see the results of the sharpening. Adjust the radius for best sharpening. When it is satisfactory, 
click OK to create a new image. The original and final images are shown below.

Sharpening brings out 
the texture of the 
feathers. 

The amount of sharp-
ening you can apply 
before artifacts start 
becoming noticeable is 
different for each 
image. In this case, a 
radius of about 23 
gave good results. 
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Adjusting Color Saturation 
After sharpening the image, we see that the colors look rather 
bleached. We can bring them out by increasing saturation.

1. Select the image window containing the image you want 
to adjust. 

2. Display the Color Saturation transformation. In the 
Transformation menu, select Color and then select Sat-
uration. The Saturation dialog box is displayed. 

3. The transformation can be used to either increase or 
decrease the saturation by moving the slider either to the right or left. Experiment to find the best setting. Click 
OK to create a new image.

Increasing saturation 
by about 40% brings 
out the colors of the 
beak and the blue 
around the eye.

Setting the Preserve 
option to Low keeps 
areas of low satura-
tion unaffected. 
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Brightening a Small Area
Eyes are frequently very important in draw-
ing us into an image. In this particular case, 
they are a bit ‘dead’. Highlights that can 
make eyes come alive are not very evident. 
However, if we look closely (detail, left), we 
can see that highlights do exist. So all we 
have to do is make them standout more.

Picture Window has a series of paint brush- like tools for making local 
changes. In this case, we will use the Lighten tool to selectively lighten 
the iris of the eye. 

To use the tool:

1. Select the image window containing the image you want to 
adjust. 

2. Enlarge the image. Click the  Zoom button in the toolbar. 
Then place the cursor over the eye and click the left mouse but-
ton until the eye fills the image window.

3. Display the Miscellaneous Tools dialog. In the Tools menu, 
select Miscellaneous Tools. This dialog offers many tools, any of 
which can be chosen from the drop-down menu. We will use the Lighten tool. 

4. You can set the tool’s Transparency and Softness. Set these to high values to reduce the degree of change in each 
pass of the tool. That makes it easier to control the effect. 
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5. Move the mouse over the image. A small circle is displayed. It shows the size of the tool. Set the Radius slider so 
that the circle is somewhat smaller than the area you want to change. 

6. Hold down the mouse button and go over the area you want to lighten. In our case, we circled around the iris, 
making a number of irregular passes to brighten it. Notice that the tool works directly on the image. (If you make a 
mistake or overdo the change, use Undo to reverse your action.) 

The results are shown below.

The original and final image are shown at the beginning of the chapter. (See Evaluating an Image.)

The final step is to save the image, described next.

 

We traced several passes 
around the iris to lighten it 
and make the eye glisten.

We also added a small high-
light to the pupil with the 
Paint Tool.

The result is to bring out the 
eye’s spherical shape and to 
make it look more alive. 
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Saving the Image
After you have adjusted the image, save it in a file. Here is the procedure:

1. Select the image window containing the image you want to save. 

2. Display File Save. In the File menu, select Save As. The standard Windows File Save dialog is displayed. 

3. Set the file type. If you intend to continue working on the image, select TIFF or one of the other uncompressed 
formats. If you have completed working with the image, and want to archive it using as little storage space as possi-
ble, save it as a JPEG compressed file. 

4. Select the drive and directory in which you want to store the image and enter a file name for the image.

5. Press OK to complete the operation. The image is saved. 

Using Other Transformations
This chapter is only an introduction to the transformations at your disposal. The transformations we performed, cropping, 
adjusting brightness, contrast, and color balance are required by most images. In addition, images frequently have dust 
marks and other small imperfections which can be removed with the Speck Removal tool. (Also see the Image Retouch-
ing Techniques white paper for an in-depth discussion.)

However, the manipulations you will want to perform ultimately depend on the image and on your creative purpose. 
Picture Window provides a very rich set of tools to help you get the most out of your photographs. 

In the next chapter, we introduce all of the Picture Window functions and describe procedures that are common to most 
of the manipulations.
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Applying Edits to Multiple Images
Frequently all the images taken at the same time will require the same editing steps. In this 
tutorial we will see how we can edit a single picture from such a series and then apply the 
edits to all the rest of the pictures by simply dragging and dropping.

The screen shot on the left shows thumbnails of a series of pictures of fishermen fishing in the 
surf. We can see from the thumbnails that the images are all pretty similar. Double-clicking on 
one of the images (IMGP0130.JPG, see below) we can see there is a decided magenta cast to 
it. So let’s remove the cast, save the modified image. We can then drag and drop the rest of 
images in the browser on top of the modified image and apply the changes to them automati-
cally. 

A sample image

Topics
1. Correct the Color Balance

2. Save the Image

3. Drag and drop to apply the 
changes to multiple images
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1. Correct the Color Balance
The Levels and Color transformation is a kind of swiss army knife which 
combines a number of operations in one dialog. Here we will use it simply 
to correct the color balance.

1. Click on the Levels and Color button in the toolbar to display the 
transformation.

2. Click on the magenta cast in one of the clouds. (You may want to exper-
iment with a few sample points, since each is a bit different.) The magenta 
will be subtracted from the image, to produce something like the image at 
left. 

3. Click OK to complete the transformation.

Note: In this example we are only adjusting the color balance. However, 
you can string together any number of operations So, for example, at this point you could add other changes. All we 
be applied automatically. 
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2. Save the Image
We will save the image by using the Save As Widget instead of the regular 
Windows Save As dialog. The Save As widget allows us to specify where 
the image will be stored as a macro, which can be applied to multiple 
images. 

1.  Select File/Save As Widget from the main menu to ope the dia-
log. The dialog lets you specify how files will be saved, including 
the file type, location, file name and other options. We will fill in 
the Destination Folder and use the defaults for everything else.

2.  Fill in the Destination Folder. We want to place the images 
into a subfolder we will call Edited. To create this macro:

a. Click the Macro button next to the Destination Folder field 
and select Current Folder from the menu. The .\ path symbol is inserted into the field.

b. Type in Edited. The field should now read .\Edited.

3. Click OK. Your current image will be saved under its current name in a subfolder named Edited.

We have now edited and saved our prototype image and are now ready to apply the same workflow steps to the other 
images in the folder.
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3. Drag and drop to apply the changes to 
multiple images
Let’s quickly look in the History window to review what we have 
done. Click the History tab in the Browser.

The History tab shows that we opened IMGP0130.JPG and per-
formed several operations on it. Each operation is noted in an 
indented list. The number associated with the operation refers to 
the image window. number The whole series of operations is called 
the workflow. If we now drop images onto the last image window, 

(Window 25), this workflow will be applied to all the dropped images.

Here is the procedure.

1. Display the last image window in the workflow. (Window 25) by 
double-clicking on its entry in the workflow.

2. Display the browser by clicking the Browser tab.

3. In the Browser window, select the images you want to edit. 

4. Drag the images to the last image window of the workflow and 
click the Apply Workflow button in the displayed dialog. 

The images are processed automatically.

Note that the images are processed in the background. If you are pro-
cessing a great many images, you can continue working in Picture Win-
dow while the background process is running.

Making Selections in the Browser

Click on an image to select it.

To select a range of images, click on the 
first image in the range. Shift click on the 
last image in the range. All images in 
between will be selected.

To select non contiguous images, Ctrl click 
on each one.

To select all images click the browser 
button.
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